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Overview

Overview

This guide contains technical installation and setup information for the staff at your company who
maintain the hardware and software required to install Deltek WorkBook.

Notes:

= This WorkBook release contains major technology and configuration changes that
affect the typical upgrade scenario. Before performing the upgrade, review the Before
You Begin Deployment section to understand how these changes will affect your
deployment.

=  This document assumes that the person installing WorkBook is capable of installing,
configuring, or troubleshooting MS SQL databases, 11S, Windows Authentication, and
Task Scheduler, among others.

Additional Information

License Renewal

For single-server installations, you can renew your license online. For dual-server installations, the Web
Server must have access to the Internet for you to renew your license.

If you do not have Internet access, you can renew your license manually within 14 days after installation.

Documentation

You can access all WorkBook documentation via the WorkBook Resource Center. The top menu bar
provides links to videos, training, and more. Scroll down to find Release Notes, Online Help, Coffee
Breaks, the Ideas Portal, and popular learning assets. Bookmark this link so that you always have easy
access to the latest information:

https://enablement.deltek.com/resource-center/workbook

You can perform a Deltek Support Center search for additional documents at the following link:
https://deltek.custhelp.com/app/answers/detail/a_id/79935

For information about the WorkBook API, you can access the Deltek WorkBook API Guide at the
following link:

https://workbookapi.deltek.com/?version=latest

Compatibility Matrix

Information about platform requirements is maintained in the Deltek Product Support Compatibility Matrix,
located on the Deltek Support Center. In the Matrix, search on “WorkBook” to navigate quickly to the
information that you need.

Deltek Product Support Compatibility Matrix

Feedback

If you have comments or questions about this document, you can submit them to
DeltekDocumentationFeedback@deltek.com.
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If You Need Assistance

If you need assistance installing or updating WorkBook, submit a request to Deltek Support Services by
navigating to https://deltek.custhelp.com » Submit a Case and completing the online form.
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Before You Begin

Before You Begin

Before you begin deployment, review the topics in this section.

WorkBook Update Program

WorkBook uses its own update manager, WorkBook Update 6, to update and install WorkBook files. This
tool connects to the Internet and downloads the necessary files required to complete a WorkBook update
or installation.

Note: If you are having issues installing the WorkBook Update 6 application, try to download
it using your browser.

Logical Tiers Overview

WorkBook uses a multitier architecture. Various components of the WorkBook application are distributed
to logical tiers for performance and scalability. The logical tiers are as follows:

=  Web/Application (lIS) Server Tier — This tier performs WorkBook’s functional process logic.
After a client browser sends a request, this tier processes that request, such as retrieving stored
data, and then returns the result to the client browser. This tier uses IS to host the WorkBook
applications.

= Agent Server Tier — This tier enables users to schedule agents that run in the background. The
following are examples of agents that can run on the Agent Server:

=  Scheduled reports

= Mail imports

= Calendar synchronization
= Database maintenance

= Database Tier — This tier consists of the SQL Server Database Server(s) where the WorkBook
data is stored and retrieved.

Installation Order: High-Level Overview

To install WorkBook correctly, you must complete installation of the server roles in the following order:

1. Install a blank and/or sample WorkBook database on the Database Server tier. You have the
option to update an existing database.

2. Install WorkBook on the Web/Application Server tier.

Install the Agent Server on the server that runs the Web/Application Server tier.

Which Type of Installation Am I Performing?

Your WorkBook installation falls into one of the following categories:

= |nstall WorkBook for the first time with a new database. For information, see Installation
Procedures.

= Upgrade a server that already has WorkBook installed. For information, see Upgrade Procedures.
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Technical Considerations

Unsupported Environments

WorkBook does not support the following environments:

= You cannot perform a single-server deployment on the Microsoft Small Business Server. Only the
WorkBook database tier can be installed on this server.

= You cannot install any WorkBook tier on:

=  The Microsoft ISA/TMG server or any other software-based firewall (except Windows
firewall).

= A domain controller.

Recommended Daily Activities
Deltek recommends that you complete the following activities on your database daily:
1. Check database integrity.

2. Perform a complete backup.

Platform Virtualization

Virtual environment software, such as VMware®, resides in the hardware layer underneath the operating
system and is used to partition a single server into a multiple-server/multiple-operating-system
environment. Deltek’s Product Development makes limited use of virtual environments.

Note: See KB Article 78800, Customer Use of Cloud-Based and Virtualized Environments, on
the Deltek Support Center site (https://support.deltek.com) for more information.
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Prerequisites

System Requirements

Make sure that your software and hardware systems meet the minimum WorkBook requirements.

If your current server does not meet the minimum software requirements as below, you must migrate
WorkBook to a new server.

Software Requirements

101 to 500+ Users

Software | 1 to 100 Users

SQL Server MS SQL Server Standard or Enterprise 2019
Notes:

= If you have fewer than 20 WorkBook users in your organization, you
can use MS SQL Server Express 2019.

= Default server-level collation must be set to
SQL_Latin1_Genereal_CP1_CI_AS

Windows Server MS Windows Server 2019+ (2019 to 2022)

Number of Servers 1 Server 1 Web Server

1 Database Server

Internet Information 8.5 or higher

Services (IS
(1) NOTE: Make sure that the IIS features that are required by WorkBook are

installed or enabled. For more information, see Installing Microsoft IIS for the
First Time on Windows Server 2019 to 2022.

ASP.NET Enabled

.NET 4.8and 8.0

NOTE: The server requires that you have Microsoft .NET 8 installed. For
instructions, see Installing Microsoft .NET 8.

Browser = Latest Chrome version for Windows and macOS
= Latest Safari version for macOS
= Latest Firefox version for Windows and macOS

= Latest Microsoft Edge version for Windows 10
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Hardware Requirements

Software /
Hardware

1 to 100 Users 101 to 500+ Users

Processor (Web and 2.5GHz Quad Core 2.5GHz Quad Core
SQL Servers)
RAM 8 Gb SQL Server: 32 Gb

Web Server: 8 Gb

Hard Disk Drive

High-performance SATA or SAS Web Server: 2 x SATA Disks in RAID 1
Disks in RAID 1

Hard Disk Space
(Estimated)

Web Server: 3 Gb + 10 Gb temporary space on the operating system disk.

NOTE: This estimate does not include file storage and the space used by the
operating system and other applications.

Ensure Permissions Required for Installing WorkBook

The person who installs WorkBook on the server tiers must have the following rights and privileges.

Permissions Required

Web Server Tier and
Agent Server Tier

=  The Windows account of the person who performs the installation must
be a member of the Local Administrator group on the server.

=  The person who performs the installation must have/know the credentials
of the user account that was in the database as specified in the
WorkBook Credentials for Microsoft SQL Server Database section. This
account has the user rights that the installation requires when it displays
the database platform connection information.

Database Server
Tier

=  The person who performs the installation must know the credentials of
the user account that was created in the database as specified in the
WorkBook Credentials for Microsoft SQL Server Database section. This
account has the user rights that the installation requires when it displays
the database platform connection information.

Ensure Credentials for Microsoft SQL Server Database

During the installation of WorkBook, you must provide a set of SQL Server Authentication credentials or a
domain account that, at minimum, should have the roles of db_owner of the WorkBook database and
dbcreator on the SQL Server.
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Note: If you choose to use a Domain Account, Deltek recommends that you rotate the
password at least once yearly. Create this account before you install WorkBook because it is
used by the Web and Agent Tiers to connect to the database.

WorkBook supports both SQL Server authentication modes: Windows Authentication Only mode or
SQL Server and Windows Authentication mode, also known as Mixed Mode.

Note: For more information about SQL Server authentication modes, see Change Server
Authentication Mode at https://msdn.microsoft.com/en-us/library/ms188670(v=sql.120).aspx.

Verify the Name of Your SQL Server Instance

The default installation uses the Server Name for the connection and is installed as an instance named
SSQLSERVER. Sometimes, Microsoft SQL Server is installed using an instance name other than the
default name (MSSQLSERVER). The SQL Server Express Edition is installed as the named instance
SQLEXPRESS.

=  When connecting to the default SQL Server Database Engine instance, use the name of your
database server. The SQL Server automatically maps the default instance of the Database
Engine to the Server Name when it accepts connections.

=  When connecting to a named instance of SQL Server Database Engine, specify the name of the
SQL Server plus the instance in the connection in the format of
SERVERNAME\INSTANCENAME.

For example, if your SQL Server is named SQLSERVER1, and you installed it to an instance
named SQLExpress, you must specify the server connection information in the format of
SQLSERVER1\SQLEXxpress.

= If you do not know the name of your SQL Server instance, or you are unable to connect to your
database server after installation, see Determine Whether the Database Engine Is Installed and
Started at http://msdn.microsoft.com/en-us/library/ms366339.aspx.

If you still experience errors when you try to connect to your database server, verify that the
Windows firewall or any other firewall is not blocking access to the SQL Server Database Engine.

Note: See Configure a Windows Firewall for Database Engine Access at
http://msdn.microsoft.com/en-us/library/ms175043.aspx.
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Preinstallation

Preinstallation Checklists

This section includes a separate checklist for each of the following installation models:

Single Server

Dual-Server (Two Tier)

Single-Server

Step

1.

Verify that your system meets WorkBook 9
software and hardware requirements. This
includes the Windows server, SQL Server,
.NET, and IIS versions, as well as the hard disk
storage size.

Note: The server requires that you have
Microsoft .NET 8 installed. For instructions, see
Installing Microsoft .NET 8.

| Related Topics

System Requirements
Microsoft .NET 8 Download Site

Appendix A: Microsoft Internet
Information Server (lIS) Installation

on Windows Server

If you are not going to use the default
installation folder, make sure that your preferred
folder exists before you install WorkBook.

Verify that the user account performing the
installation is a member of the local Windows
System Administrators group.

Permissions Required for Installing

WorkBook

Make sure that you have valid SQL Server
credentials or a domain account available for
use during the installation.

WorkBook Credentials for
Microsoft SQL Server Database

Use the SQL Server Configuration Manager to
enable the TCP/IP and Shared Memory
protocols on the SQL Server.

Enable or Disable a Server
Network Protocol (SQL Server
Configuration Manager)
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Dual-Server (Two-Tier)

Database Tier

You must perform this step before you install WorkBook on your Web Server.

Step

1.

Verify that the Database Server meets
WorkBook’s software and hardware
requirements.

Related Topics

System Requirements

Use the SQL Server Configuration Manager to
ensure that the TCP/IP and Shared Memory
protocols are enabled on your report server
and database server.

2. Verify that the user account performing the = Permissions Required for Installing
installation is a member of the local Windows WorkBook
System Administrators group.

3. | Make sure that you have valid SQL Server =  WorkBook Credentials for
credentials or a domain account available for Microsoft SQL Server Database
use during the installation.

4. .

Enable or Disable a Server
Network Protocol (SQL Server
Configuration Manager)

Web Application and Process Server Tier

Step

1.

Verify that the Web Application and Process
Server meets WorkBook’s software and
hardware requirements.

Note: The server requires that you have
Microsoft .NET 8 installed. For instructions, see
Installing Microsoft .NET 8.

Related Topics

System Requirements
Microsoft .NET 8 Download Site

Appendix A: Microsoft Internet
Information Server (11S)
Installation on Windows Server

Verify that the user account performing the
installation has the proper account credentials
as stated in the database tier checklist.

2. | If you are not going to use the default
installation folder, make sure that your
preferred folder exists before you install
WorkBook.
3. =

WorkBook Credentials for
Microsoft SQL Server Database
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Related Topics

4. | Ensure that you have the following information = WorkBook Credentials for
before you start the installation: Microsoft SQL Server Database
= Database Server\SQL instance name = Verify the Name of Your SQL

Server Instance.

= Database Server credentials

Restore the WorkBook Database

Before you install WorkBook, you must restore the WorkBook database on your SQL Server. If you do not
have the WorkBook database, contact DeltekSupport@deltek.com.

For information on how to restore an SQL database, see Restore a Database using SQL Server
Management Studio.

Note: If you experience connection errors to your database and have verified the previous
steps, check that access is not being blocked by Windows or your firewall. For more
information, see Configure a Windows Firewall for Database Engine Access.
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Installation Procedures

Note: If you encounter any errors during the installation, send the installation log file to
WorkBookSupport@deltek.com.

Single-Server Installation

This section provides instructions for installing all WorkBook tiers on a single server for organizations that
prefer the one-server deployment model. This deployment model is suitable for demonstration purposes
or for small organizations that have simple deployment needs.

When you choose the one-server deployment model, you install all WorkBook tiers (Web, Agent, and
Database) on the same server.

Notes:

= Before you begin your installation, see Preinstallation Checklists and System
Requirements.

= To review the various deployment options, see Before You Begin Deployment.

Step 1: Install the Web/Application (IIS) and Database Server Tiers

1. Create the WorkBook installation folder on your server.

2. Navigate to https://update.workbook.net/wbupdate6/ and click Install on the page to download
WorkBook Update 6. This option also downloads the Microsoft .NET and Windows Installer
prerequisites.

If you already have the prerequisites installed, you can launch WorkBook Update 6 directly from
the page.

Note: Make sure to restore the WorkBook database before launching WorkBook Update 6.
For more information, see Restore the WorkBook Database.

3. Right-click setup.exe and then click Run as administrator on the context menu. Alternatively,
you can double-click setup.exe and then click File » Elevate Application in the WorkBook
Update 6 dialog box.

Installation Guide 1
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4. Use the WorkBook Update 6 dialog box to specify the database information and installation path

for WorkBook V9 Website. If you are using Trusted Authentication, leave the username and
password fields empty.

the V9 Website Path field, as shown in the following example. If you want to change the

folder should not exceed 100 characters.

Note: When you select a Database Server in WorkBook Update 6, it automatically populates

default paths, make sure that the destination folders that you want to use already exist before
you start with the installation. The maximum path name length from the root to the installation

File  Get Database Info  About
Frontend Path

Database Info
Server: Iservernom

Usemame: |username1

|
|
Password: |o.uouoo |
|

Database: |wbDatabaseName

Connection String: | DataSource:servernom;lniﬁalCatalog=wbDatabaseName;IntegratedSe|

New version
512000.67 Stable 12/18/2019

Silverdight Path
FwwwrootiDatabaseMName\Silverlight

V9 Website Path
CWBDatabaseName

Update Info
[v] Patch [ Static Data [ | Sivedight [v] V9 Cument Build: 91200047
[] Backend [] Use HTTPS Latest Buid: 312000.67

[[] Use HTTPS (Reverse Proxy) Oriine Users: 0

12/19/2019 8:33:23 PM - Ready

Installation Guide
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5. In the Update group box, select the following options:

= Patch
= Static Data
= V9

= Backend

Notes:

= Select the Backend option only if you are upgrading from one major version to
another. For example, select this option if you are upgrading from version 911000 to
version 912000. If you are upgrading from version 911000.102 to version
911000.107, do not select this option because both versions belong to the same
major release (911000).

= For version 913600 and higher the HTTPS is always enabled. The checkbox Use
HTTPS can be ignored. Remember to install SSL Certificate for HTTPS.

6. Inthe New version section, use the drop-down list to select the version of WorkBook that you
want to install.

Note: Select a stable version of WorkBook, unless told otherwise by Deltek.

7. Inthe V9 Website Path field, specify the location where you want to install the V9 Website
Application files.

8. Click Start and wait for the installation to finish.

Step 2: Create the Website and Configure the IIS Settings

Note: If you want to create a separate website for reports, use the following method instead:
Appendix B: Creating the Website and Configuring the IS Settings (Alternate Method).
Having the reports on a separate website can help to speed up processing time and can
generally be less demanding of system resources.

1. Open the Internet Information Services (1IS) Manager.

2. Expand the server element.

3. Right-click Application Pools and click Add Application Pool... on the context menu.
4

Set the name for the Application Pool which is for WorkBook website, set .NET CLR version to
No Managed Code, Managed pipeline mode to Integrated and Start application pool
immediately checked.

o

Right-click Application Pools and click Add Application Pool... on the context menu.

6. Set the name for the Application Pool which is for Reports, set .NET CLR version to .NET CLR
Version v4.0, Managed pipeline mode to Integrated and Start application pool immediately
checked.

Right-click Sites and click Add Website on the context menu.

Use the fields and options in the Add Website dialog box to create the WorkBook website,
Select... Application pool and choose the one created in the point 4. then click OK.

Installation Guide 13
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Make sure that the Physical Path field points to the WorkBook installation folder that you
specified when you installed the Database and Web tiers, and that the Port field points to an
unused port number, then click OK.

9. Expand the newly created WorkBook website.
10. Right-click the api folder and click Convert to Application on the context menu.

11. In the Add Application dialog box, make sure selected Application pool is the one from the point
4. and accept the other default settings and click OK.

12. Right-click the Report folder and click Convert to Application on the context menu.

13. In the Add Application dialog box, make sure selected Application pool is the one from the point
6. and accept the other default settings and click OK.

14. Expand Report.
15. Right click the api folder and click Convert to Application on the context menu.

16. In the Add Application dialog box, make sure selected Application pool is the one from the point
6. and accept the other default settings and click OK.

Step 3: Download the Agent for Your WorkBook Version

When installing WorkBook in a single-server or dual-server setup, you must download the agent version
that matches your WorkBook installation.

1. Click http://update.workbook.net/912000 to go to the download site.

The agent version number after the slash corresponds to the version number of the base
WorkBook application.

2. Download the WorkBook agent version that corresponds to your installation’s build number. The
last two digits of the file name correspond to the build number of your WorkBook installation. For
example, if your WorkBook build number is 912000.27, download
workbookagentconsole_27.zip. The build number is displayed in the New Version field of the
WorkBook Update 6 dialog box.

3. Create an Agent folder for the WorkBook agent on the server where your Web/Application Server
is installed. The Agent folder must be on the same level as the installation folder for your
WorkBook installation.

4. Extract the contents of the zip file to the Agent folder.

Step 4: Configure the Agent Server Tier

1. In the WorkBook installation folder on your Web/Application (IIS) Server, right-click the
Web.config file and use the context menu to open it in Notepad.

2. In Notepad, copy the connection string from the Web.config file.
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File Edit Sesrch View Encoding Lsmguige Settngs Tools Maom Rum Plugms Window !
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-— B e —

» . W = 2

- ST . S e e T
e
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</configSectiona®
£!-— Connection String —-*

£¥-- Applicatichn Feitinge --»
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£l== Bapicly, don"c makbe new usess for each login, this does not wosk with AIURE!==>»
o e )
- e el — e S >

-
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3. Inthe wbAgent folder of your Web/Application (IIS) Server, right-click the

WorkBook.Agent.ConsoleRunner.exe.config file and use the context menu to open it in
Notepad.
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4.

5.

In the WorkBook.Agent.ConsoleRunner.exe.config file, overwrite the Agent’s connection string
with the one that you copied from the Web.config file in the WorkBook installation folder.

Wi CAUsers\ I\ DeskiophwhAgent\WorkBook Agent ConsoleRunner.exe.config - Notepads++ | = | © IR
File Edit Semch Wiew Encoding Lengusge Settingt Teck Maom Run Pluging Window 7 X
sHEHE B T2 shR 2 g x x — EE B F | E R e
B changslog .Ilj- 1 |"_'| fig = Work Book Agent Console Funres axe config 'Jl
cPum] weraions"l.0" encoding="ntf-8" % #
</ AppIeTTingar
=] sessmest isnSerings>

<add name="ConnectionString” connecticnString="Data scurce= abol2d.xyz.deltek.com;Initial Catalogewhil

</ conmectionStrings>

eXtenuible Marbup Language Tile lersgth: 3076 hnes: T3 La:T Col:1 Sel: 2053 Linex {LF) UITF=E-B0OM

Save the file.

Step 5: Create a Scheduled Task

1.

Launch Task Scheduler and create a task (Action » Create Task).
On the General tab of the Create Task dialog box, enter the task name.
Select the following options:
= Run whether User is Logged on or not.
Do not select the Do not Store Password option.

= Run with Highest Privileges
On the Trigger tab of the Create Task dialog box, click New.

In the New Trigger dialog box, select the following options, then click OK:
= Begin the task on a schedule

= Daily

= Recur every 1 day

= Repeat task every 1 hour for an indefinite duration

= Enable the trigger
On the Actions tab of the Create Task dialog box, click New.

In the New Action dialog box, take the following actions, then click OK:

= Select Start a Program in the Action field.

]
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= Use the Browse button to locate the WorkBook.Agent.ConsoleRunner.exe file in the Agent
folder.

8. Inthe Create Task dialog box, click OK.

Two-Server Installation

This model is designed for medium- to large-sized companies that have adequate technical staff. In this
setup, your SQL and IIS installations run on different servers.

Notes:

= Before you begin your installation, see Preinstallation Checklists and System
Requirements.

= To review the various deployment options, see Before You Begin Deployment.

Step 1: Install the Web/Application (IIS) Server Tier

1. Create the WorkBook installation folder on the server that hosts the 1IS Server.

2. Navigate to https://update.workbook.net/wbupdate6/ and click Install on the page to download
WorkBook Update 6. This option also downloads Microsoft .NET and Windows Installer
prerequisites.

If you already have the prerequisites installed, you can launch WorkBook Update 6 directly from
the page.

Note: Make sure to restore the WorkBook database before launching WorkBook Update 6.
For more information, see Restore the WorkBook Database.

3. Right-click setup.exe and then click Run as Administrator on the context menu. Alternatively,
you can double-click setup.exe and then click File » Elevate Application in the WorkBook
Update 6 dialog box.

4. Use the WorkBook Update 6 dialog box to specify the database information and installation path
for WorkBook V9 Website. If you are using Trusted Authentication, leave the username and
password fields empty.

Note: When you select a Database Server in WorkBook Update 6, it automatically populates
the V9 Website Path field, as shown in the following example. If you want to change the
default paths, make sure that the destination folders that you want to use already exist before
you start with the installation. The maximum length of the path name from the root to the
installation folder should not exceed 100 characters.
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File  GetDatabaseInfo  About
Frontend Path

Database Info
Server: Iser\ferUUU‘I

Usemame: |usemname1

Database: |wbDatabaseName

|
|
Password: |oouoouo |
|
|

Connection String: | Data Source=senverD001;Initial Catalog=wbDatabaseName;Integrated Se

New version

912000.67 Stable 12/18/2019

Silveright Path

|
| FwwwrootiDatabaseMame\Silverlight

V3 Website Path

CWBDatabaseMName

Update Info
[v] Patch [ Static Data [ ] Siveright [v] V3 Current Build: 912000.47
mE L L Latest Buid: 912000.67

[[] Use HTTPS (Reverse Proxy) o Usess: 0

12/19/2019 8:33:23 PM - Ready

5. In the Update group box, select the following options:

= Patch
= Static Data
= V9

= Backend
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8.

Note:

= Select the Backend option only if you are upgrading from one major version to
another. For example, select this option if you are upgrading from version 911000 to
version 912000. If you are upgrading from version 911000.102 to version
911000.107, do not select this option because both versions belong to the same
maijor release (911000).

=  For version 913600 and higher the HTTPS is always enabled. The checkbox Use
HTTPS can be ignored. Remember to install SSL Certificate for HTTPS.

In the New Version section, use the drop-down list to select the version of WorkBook that you
want to install.

Note: Select a stable version of WorkBook, unless told otherwise by Deltek.

In the V9 Website Path field, specify the location where you want to install the V9 Website
Application files.

Click Start and wait for the installation to finish.

Step 2: Create the Website and Configure the IIS Settings

Note: If you want to create a separate website for reports, use the following method instead:
Appendix B: Creating the Website and Configuring the 1IS Settings (Alternate Method).

Having the reports on a separate website can help to speed up processing time and can
generally be less demanding of system resources.

9.

On the server where you installed the Web/Application (IIS) Server tier, open the Internet
Information Services (1IS) Manager.

Expand the server element.
Right-click Application Pools and click Add Application Pool... on the context menu.

Set the name for the Application Pool which is for WorkBook website, set .NET CLR version to
No Managed Code, Managed pipeline mode to Integrated and Start application pool
immediately checked.

Right-click Application Pools and click Add Application Pool... on the context menu.

Set the name for the Application Pool which is for Reports, set .NET CLR version to .NET CLR
Version v4.0, Managed pipeline mode to Integrated and Start application pool immediately
checked.

Right-click Sites and click Add Website on the context menu.

Use the fields and options in the Add Website dialog box to create the WorkBook website,
Select... Application pool and choose the one created in the point 4. then click OK.

Make sure that the Physical Path field points to the WorkBook installation folder that you
specified when you installed the Database and Web tiers, and that the Port field points to an
unused port number, then click OK.

Expand the newly created WorkBook website.

10. Right-click the api folder and click Convert to Application on the context menu.
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11. In the Add Application dialog box, make sure selected Application pool is the one from the point
4. and accept the other default settings and click OK.

12. Right-click the Report folder and click Convert to Application on the context menu.

13. In the Add Application dialog box, make sure selected Application pool is the one from the point
6. and accept the other default settings and click OK.

14. Expand Report.
15. Right click the api folder and click Convert to Application on the context menu.

16. In the Add Application dialog box, make sure selected Application pool is the one from the point
6. and accept the other default settings and click OK.

Step 3: Download the Agent for Your WorkBook Version

You must run the Agent from the server where your Web/Application (11S) Server is installed.

Notes:
= This section applies only to clients who host WorkBook on their own servers.

= You must extract the Agent to the Web/Application (1IS) Server and not to the SQL
server.

When you install WorkBook in a single-server or dual-server setup, you must download the Agent version
that matches your WorkBook installation.

1. Click http://update.workbook.net/912000 to go to the download site.

The agent version number after the slash corresponds to the version number of the base
WorkBook application.

2. Download the WorkBook agent version that corresponds to your installation’s build number. The
last two digits of the file name correspond to the build number of your WorkBook installation. For
example, if your WorkBook build number is 912000.27, download
workbookagentconsole_27.zip. The build number is displayed in the New Version field of the
WorkBook Update 6 dialog box.

3. Create an Agent folder for the WorkBook agent on the server where your Web/Application Server
is installed. The Agent folder must be on the same level as the installation folder for your
WorkBook installation.

4. Extract the contents of the zip file to the Agent folder.
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Step 4: Configure the Agent Server Tier

1.

2.

3.

4.

In the WorkBook installation folder on your Web/Application (1I1S) Server, open api folder, right-
click the appsettings.Production.json file and use the context menu to open it in Notepad.

In Notepad, copy the connection string from the Web.config file.

H *Chinetpublwwwroot'V9latest\api\appsettings.Production.json - Notepad++ —
File Edit Search View Enceding Language Settings Tools Macro Run  Plugins  Window 7

sHEHBR LRI i hE2e|®dn| % x| 1 EFEERAe® @ Bl
Bappsettings.Production.json tzl

2 E "ConnectionStrings": {
3 "ConnectionString”: "Server=localhost;Database=wbdatabase;Trusted Connection=True;"
4 = b
5 -l -l I- AE NI I‘ L___N |

LR R RS L LI L LT N _ LR NN LTl LN
wll Sl

{THTY

g By Tl B T B R
e dams FRAFM [ =

o
R =

{T}

LT
1

L

In the wbAgent folder of your Web/Application (IIS) server, right-click the
WorkBook.Agent.ConsoleRunner.exe.config file and use the context menu to open it in
Notepad.

In the WorkBook.Agent.ConsoleRunner.exe.config file, overwrite the Agent’s connection string

with the one that you copied from the Web.config file in the WorkBook installation folder.
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i €A Users\ B\ DeskiophwhAgent\WorkBook Agent ConsoleRunner.exe.config - Notepad++ | = | © IR
Fde Edt Sesch WVebw Ercoding Linguage Seftings Tockh Maco Run Pluging Window 7 |
sOEHE R R s DOk 2 A% & x s = @ F e R =
Bl change og | Bl 1 1| B Web confi 1 1mwmcﬂmmmcma|

€hml versior="1.0" encoding="ntf-8"3» .

Coonf i mETA T O

S AppIeTTAnga>
2] <ecoamectiondtringss

<add name="ConnectionString” connecticnString=-"Data scurce= abol?d.xyz.deltek.com;Initial Cataloge=whil
i/ connectionStringal

eXtengible Marbup Language Tile lersgthi: 5078 hnes: TS La:T Cal:1 Ssl: 253 Line {LF) UTF=E:BOM S

5. Save thefile.

Step 5: Create a Scheduled Task

1.

On your Web/Application (IIS) Server, launch Task Scheduler and create a task (Action » Create
Task).

On the General tab of the Create Task dialog box, enter the task name.
Select the following options:
= Run whether User is Logged on or not.

Do not select the Do not Store Password option.

= Run with Highest Privileges
On the Triggers tab of the Create Task dialog box, click New.

In the New Trigger dialog box, select the following options, then click OK:
= Begin the task on a schedule

= Daily

= Recur every 1 day

= Repeat task every 1 hour for an indefinite duration

= Enable the trigger
On the Actions tab of the Create Task dialog box, click New.

In the New Action dialog box, take the following actions, then click OK:
=  Select Start a Program in the Action field.

= Use the Browse button to locate the WorkBook.Agent.ConsoleRunner.exe file in the Agent
folder.
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8. Inthe Create Task dialog box, click OK.
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Upgrade Procedures

Deltek encourages clients to upgrade to the latest version of WorkBook because:
= New features are added only to the latest version.
= Deltek fixes software issues only in the latest version, except in critical situations.
= Deltek support is typically available only for the latest and the next previous versions.
= The latest version incorporates the newest technologies and tools.

Before you install an upgrade, review the Deltek WorkBook Release Notes and perform a test conversion
and test installation of the new version to ensure that your Company’s business processes are working
properly in the new version.

Notes:

= Before you begin your installation, review Preinstallation Checklists.

= To review the various deployment options, see Before You Begin Deployment.

= If you encounter any errors during the upgrade process, send the installation log file
to https://support.deltek.com.

=  When it updates the Database Server tier, WorkBook creates a backup of the
database in the default backup directory.

Upgrade from WorkBook 9.1 or Newer

If you are upgrading from WorkBook 9.1 or a newer version, the upgrade is installed directly into the
existing folder structure using the current WorkBook settings.

Upgrade from WorkBook 8 or Earlier Versions

If you are upgrading from WorkBook 8 or an earlier version, you might need to create one or more of the
Application websites if they are missing. WorkBook uses any existing websites.

Migrate/Upgrade to a New Server

= |f your existing WorkBook database server is on an SQL Server version that is no longer
supported, you must restore or move your database to a supported version before you install the
upgrade.

= If your existing WorkBook Web/Application Server is on a version of Windows that is no longer
supported, you must perform a new installation. WorkBook will not migrate any custom reports,
DLLs, web.config settings, or other configuration changes that are on the server. For more
information, see Installation Procedures.

Step 1. Install the Web/Application (IIS) Server Tier

1. Navigate to https://update.workbook.net/wbupdate6/ and click Install on that page to download
WorkBook Update 6. This option also downloads Microsoft .NET and Windows Installer
prerequisites.
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2. Right-click setup.exe and then click Run as Administrator on the context menu. Alternatively,
you can double-click setup.exe and then click File » Elevate Application in the WorkBook
Update 6 dialog box.

3. Use the WorkBook Update 6 dialog box to specify the database information and installation path
for WorkBook’s V9 Website components. If you are using Trusted Authentication, leave the
username and password fields empty.

() WorkBook Update 6 \L‘E-

File  Get DatabaseInfo  About

Frontend Path

|C:\W‘BEnuyEngH1\Wd:.mrﬂg H Browse ‘
Start

Database Info

Server: senverdnod

Usemame: |username1

Password: |eessssses

Database: |wbDatabaseName

Connection Stnng Data Source=server0001;Initial Catalog=wbDatabaseName;Integrated Se

New version
|912000.47 Alpha 12/4/2019 v

V9 Website Path Oniy change i you wish to use a custom path

C:\WBDatabaseName I Browse
Update Info

[ Patch [V Static Data [ | Sivedight [ V3 Curment Build: 31200047
[[] Backend [] Use HTTPS Latest Build: 91200067

[T Use HTTPS (Reverse Proxy) Orline Users: 0

12/19/2019 8:33:23 PM - Ready

4. Inthe Update group box, select the following options:

= Patch

= Static Data
= V9

= Backend
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5.

6.

In the New version section, use the drop-down list to select the version of WorkBook that you
want to install.

Note: Select a stable version of WorkBook, unless told otherwise by Deltek.

Click Start and wait for the installation to finish.

Step 2: Download the Agent for Your WorkBook Version

Notes:

This section applies only to clients who host WorkBook on their own servers.

If your SQL and IIS installations run on different servers, extract the Agent to the
Web/Application (lIS) Server and not to the SQL server.

When you install WorkBook in a single-server or dual-server setup, you must download the Agent version
that matches your WorkBook installation.

1.

Click http://update.workbook.net/912000 to go to the download site.

The agent version number after the slash corresponds to the version number of the base
WorkBook application.

Download the WorkBook agent version that corresponds to your installation’s build number. The
last two digits of the file name correspond to the build number of your WorkBook installation. For
example, if your WorkBook build number is 912000.27, download
workbookagentconsole_27.zip. The build number is displayed in the New Version field of the
WorkBook Update 6 dialog box.

Go to Task Manager » Details and stop WorkBook.Agent.ConsoleRunner.

i Task Manager = O >
File Options View

Processes Performance Users Details Services

Name a PID Status User name CP.. Memory.. Description £
§F_'lf]WorkBookAgent.ConsoleRunner.e)(e 5628 Running Student 00 24,192 K WorkBook . Agent.ConsoleRunner W
< >

Fewer details End task N

Delete the content of the Agent folder on the server where your Web/Application Server is
installed.

Extract the contents of the zip file to the Agent folder.
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Step 3: Configure the Agent Server Tier

1. In the WorkBook installation folder on your Web/Application (1IS) Server, right-click the
Web.config file and use the context menu to open it in Notepad.

2. In Notepad, copy the connection string from the Web.config file.

Web.conlig - Notepad [= = =]

Fle Edt Fornat  Yeew Help
<ixml verslon="1.8" encoding="utf-8°i>
<configurations
tconfigSectionss
s<sectionGroup namse="devExpress™:

¢ feonfigSectionts
¢!-- Connectlon String --»

cappiettings»

€ i

3. Inthe wbAgent folder of your Web/Application (1IS) server, right-click the
WorkBook.Agent.ConsoleRunner.exe.config file and use the context menu to open it in
Notepad.

4. In the WorkBook.Agent.ConsoleRunner.exe.config file, overwrite the Agent’s connection string
with the one that you copied from the Web.config file in the WorkBook installation folder.

Save the file.

Go to Task Manager » Details and check whether the WorkBook.Agent.ConsoleRunner.exe is
running. If not, open Task Scheduler and run the scheduled task.

Step 4: Remove Obsolete Websites
WorkBook has rendered the following websites obsolete:
= “Mobile” APl website.
=  WebAccess website.

You can delete these websites and the files that are related to them.
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Post Installation/Upgrade

After you complete the installation or upgrade process, verify the installation to confirm that all
prerequisite software is installed and that all installation steps were completed.
To verify that your installation was successful:
1. Open your browser and enter the URL to the WorkBook application, for example:
http:\\<sWeb Server>\
2. Enter your User ID. If you are unsure of your user ID, enter admin.
Enter your Password. If you are unsure of your password, leave this field empty.

4. If you are able to log in, or if you receive a notification about an incorrect username or password,
WorkBook has been installed successfully.

Note: If there are any errors during the installation process when reloading reports, they are
listed in the installation log. Resolve any errors and reload your reports manually through the
application.

Post-Installation Configuration

After the installation is complete, you must perform the following configuration steps.

Step 1. Update the BasicURL

Run the following script to update the BasicURL to match the one that you supplied to WorkBook
in IS, where WORKBOOKURL is your WorkBook system’s URL.

update SysVariabler set Vaerdi = 'WORKBOOKURL' where VariableNavn =
'BasicURL'

Step 2: Get Your Subscription Key
1. Contact Deltek Support Services to get your Subscription Key and copy it.

2. In WorkBook, navigate to Settings » Advanced Tools » License Management » Renew
License tab.

3. Inthe Enter New License Key (new user or module) section, click Enter New Key, paste the
Subscription Key in the field, and click OK.

A confirmation message is displayed.
Click OK.

If it is for a Production Server, click Mark System as Production.

License management

@aw system as production Current licence information Renew License  |jcense key v
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Storage Providers

If you have moved your WorkBook installation to a new server, and you use a Local Data Provider, be
sure to move this database if they are on the same server, and update the Data Provider location in
Settings » Folders, Reports, & Documents » Storage and Folders » Storage Provider tab.

License holder name @X RYll Storage and folders
Resource folder setup | Job folder setup Storage provider Ef D Q {@}
1ax Display name Class name Ena...
Clients & resources Windows Azure Storage AzureStorageProvider O
Google Drive GoogleDriveStorageProvider O
CRM setup
WebDAV WebDAVProvider O
Employee settings
File System 105torageProvider
Global system settings
Folders, reports & documents
Corporate reporting setup (308)
Document templates
Email templates
Finance account groups
Finance reports configuration
Financial postings report (264)
Report attachments My settings Type Required = Value
Report filenames RootDirectory String C:\WorkBook Storage
Report layouts and watermarks ShowHiddenFiles Boolean
Report profiles
Storage and folders

Emails

If you have changed the URL as part of the migration, update System Variable 911 HTML5 Version 9
URL Redirect in Settings » Global System Settings » System Variables to match the new URL.

Sys

Search Find variable number '911":
¥ Global system settings ~ o
Y & & Search 911 HTMLS version 9 URL redirect
System variables Find setting number https://EmptyEnglish.workbook.net
a1 X
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A-record

After the migration is complete, update any records that point the URL to the server.
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Appendix A: Microsoft Internet Information
Server (IIS) Installation on Windows Server

Microsoft (IIS) is already Installed on Windows Server 2019
to 2022

If you have already enabled the Web Server role on your web server, you must check Features and Role
Services.
To check Features and Role Services on Windows Server 2019 to 2022:

1. Launch Server Manager.

2. Inthe left menu, click lIS. If the 1IS option is not listed, perform the following steps for installing
Microsoft IIS for the first time.

3. Inthe Roles and Features group, verify that all of the required role services (as listed in Installing
Microsoft IIS for the First Time) are installed.

Installing Microsoft IIS for the First Time on Windows
Server 2019 to 2022

If you are installing Microsoft IIS for the first time, perform the following the steps. These steps are
required for proper detection of ASP.NET.
To install Microsoft IIS on Windows Server 2019 to 2022:
1. Log in to Microsoft Windows Server as a domain or local administrator.
Launch Server Manager.

2
3. On the Server Manager dashboard, select Add Roles and Features.
4. On the Before You Begin page, click Next.

5

On the Select Installation Type page, select Role-Based or Feature-Based Installation and
click Next.

6. On the Select Destination Server page, select Select a Server from a Server Pool and click
Next.

7. On the Select Server Roles screen, expand Web Server (IIS) and enable the following options:
= Web Server (lIS) » Web Server » Common HTTP Features
= Default Document
= HTTP Errors
=  Static Content
= HTTP Redirection
= Web Server (lIS) » Web Server » Health and Diagnostics
=  HTTP Logging

= Request Monitor
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Know more.
Do more.®

= Tracing
= Web Server (lIS) » Web Server » Performance
=  Static Content Compression
= Web Server (lIS) » Web Server » Security
=  Windows Authentication
= Request Filtering
= Web Server (lIS) » Web Server » Application Development
= .NET Extensibility 4.8
= ASP.NET 4.8
=  Web Server (lIS) » Management Tools
= |IS Management Console
= [IS Management Scripts and Tools
Click Next.

On the Select Features page, expand .NET Framework 4.8 Features and select .NET
Framework 4.8 and ASP.NET 4.8.

Click Next.

Notes: These steps enable the .NET features. However, you must also install the currently
supported version of the .NET on the server, if you have not already. For more information
see Software Requirements.

9.

On the Confirm Installation Selections page, click Install.

Installing Microsoft .NET 8

The server requires that you have Microsoft .NET 8 installed.
To install .NET 8.0:

1.

2
3
4.
5

Go to .NET 8.0 website using this link.

Go to the ASP.NET Core Runtime section and find the OS / Installers / Binaries table.
Under Windows » Installers, find and download Hosting Bundle.

Double-click the file, and then click Install.

After the installation is complete, click Close.

Installation Guide

32


https://dotnet.microsoft.com/en-us/download/dotnet/8.0

Deltek gwumore

Appendix B: Creating the Website and Configuring the 1IS Settings (Alternate Method)

Appendix B: Creating the Website and
Configuring the IIS Settings (Alternate Method)

Use this method if you want to create a dedicated website for reports. Having a separate report website
can generally be less demanding of system resources and might help to speed up processing time.

Create the Website and Configure the IIS Settings

In your browser, go to https://www.iis.net/downloads/microsoft/url-rewrite.

Download and install the URL Rewrite extension.
Open the Internet Information Services (IIS) Manager.
Expand the server element.

Right-click Sites and click Add Website on the context menu.

I T o

Use the fields and options in the Add Website dialog box to create the WorkBook website, then
click OK.

Make sure that the Physical Path field points to the installation folder that you specified when
you installed the Database and Web tiers, and that the Port field points to an unused port
number.

7. Expand the newly created WorkBook website.

8. Right-click the api folder and click Convert to Application on the context menu.

9. In the Add Application dialog box, accept the default settings and click OK.

10. Right-click the Report folder and click Convert to Application on the context menu.

11. In the Add Application dialog box, accept the default settings and click OK.

Remove Report as Application

1. Right-click Report and click Remove on the context menu.

2. When prompted for confirmation, click Yes.

Rename the Report Folder

1. Right-click the WorkBook website that you created and click Explore on the context menu.

2. Locate the Report folder and rename it to something else, for example, ReportSite.

Create a Separate Report Website

1. Go back to the 1IS Manager and press F5 on your keyboard to refresh.
2. Right-click Sites and click Add Website on the context menu.

Use the fields and options in the Add Website dialog box to create the report website, then click
OK.
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Know more.
Do more.®

Attention: Make sure that the Physical Path field points to the folder that you just
renamed—in this example, ReportSite—and that the Port field points to an unused port
number that is different from that of the WorkBook website.

4. Expand the report website that you just created.
5. Right-click the api folder and click Convert to Application on the context menu.

6. Inthe Add Application dialog box, accept the default settings and click OK.

Configure the web.config File

1. Right-click the WorkBook website and click Explore on the context menu.
2. Locate the web.config file and use the context menu to open it in Notepad.
3. Scroll to the bottom and place your mouse cursor just before <system.webServer>.
4. Paste the following string, then save the file.
<rewrite>
<rules>
<rule name="WorkBook Report Redirect" stopProcessing="true">
<match url=""report\/(.*)" />
<conditions trackAllCaptures="true">
<add input="{CACHE URL}" pattern=""(.+)://" />

<add input="{ CACHE_URL} "
pattern=" (report\/api\/) | (report\/.*\.a) | (report\/.* (\.html))" />

</conditions>

<action type="Rewrite" url="http://{SERVER NAME}:1000/{R:1}" />
</rule>
<rule name="DXR.axd" stopProcessing="true">

<match url="DX[X]?R.*\.axd" />

<action type="Rewrite" url="http://{SERVER NAME}:1000/{R:0}" />
</rule>
<rule name="WebResource.axd" stopProcessing="true">

<match url="WebResource\.axd" />

<action type="Rewrite" url="http://{SERVER NAME}:1000/{R:0}" />
</rule>

</rules>

</rewrite>
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Edit the Rules Using URL Rewrite

1. Navigate to the WorkBook website.

2. In the right pane of the IS Manager, double-click URL Rewrite.

3. Inthe URL Rewrite pane, double-click a rule.

4. In the Edit Inbound Rule pane, change the value of the Rewrite URL field:
= Replace 1000 with the port that you used for the report website.
= Make sure that the binding type—http or https—matches that of the WorkBook website.
In the Actions pane, click Apply.

Apply the same changes to the two other rules.
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